
CGS 2545: Database Concepts  (Lab #4)              Page 1 © Dr. Mark Llewellyn

CGS 2545: Database Concepts

Spring 2014

LAB #4

Department of Electrical Engineering and Computer Science

Computer Science Division

University of Central Florida

Includes Lab Assignment #4 – Due March 28th

Course Instructor : Dr. Mark Llewellyn

Lab Instructors : Arup Ghosh and Rui Hou



CGS 2545: Database Concepts  (Lab #4)              Page 2 © Dr. Mark Llewellyn

Lab #4 – The User Interface
• The objective of this lab is to introduce you to the navigation

form in Access.

• The navigation form replaced the older style switchboard
beginning with Access 2010. The navigation form is the
component of Access which deals with the user interface.

• While you are becoming a proficient user of/and
knowledgeable in the organization of Access, many potential
users of the databases that you will develop are not.

• The user interface ties the various database objects together in
such a manner that the database is easy to use for even a non-
skilled user.

NOTE: In the slides that follow, if the call-out symbol is

outlined in red, it means that there is something for you to try, if

the call-out is outlined in blue, I am simply giving you some

information about what is displayed on that page.
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• In lab #3 you examined forms that allowed a user to enter data

into a database table without directly accessing the datasheet

(raw table) view of the data.

• The navigation form is a special type of form that allows the

user to navigate through the various database objects, e.g.,

queries, forms, and reports, that you would like them to be

able to utilize.

• The navigation form provides a familiar Internet-style

interface that allows you to access multiple objects in the

database from one central location.

• The Northwind database that you’ve used in previous labs

starts up initially with the Switchboard (old style) being

displayed. We’ve turned this off immediately before.

Lab #4 – The User Interface
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The Northwind sample 

database switchboard
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Creating A Navigation Form

• Since the navigation form provides a user with the ability
to manipulate various objects in the database from a high-
level perspective, it is required that you create a navigation
form on an already created database. Preferably one with
queries, forms, reports, and possibly other objects defined.
In other words, you can’t create the navigation form first.

• Although it is an older style interface, I would suggest that
you look at the definitions for the switchboard that is
defined in the Northwind sample database first, before you
continue with this lab.

• The next couple of pages illustrate some of the
switchboard components for the Northwind database.
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Click on the Categories button on the 

main switchboard and you’ll see this 

form appear.  This is a form that lets 

the user see all of the categories 

maintained in the database.
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Notice that the form on the previous 

page appears as the first form in the 

listing of forms.  The switchboard is 

simply providing a shortcut to the form.
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The orders form as accessed from the 

main switchboard is again, just another 

form already created in the database.
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Creating A Navigation Form

• Having looked at the Northwind switchboard, lets now

move on and look at the more current technique using

the navigation form.

• To do this, download the spaDB database from either

the course website, the database download section or

the lab section (Lab 4) on WebCourses.

• This database has been created with a several different

tables, forms, reports, and navigation forms already set-

up.

• Once you download this database, open it in Access

and you should see the following screen.
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Click on the frmEmployeeNavigation 

and you’ll see the form on the next 

page appear.  
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This form provides access to all the 

forms and reports related to the 

employees in the database.  The blue 

navigation buttons on the left side 

represent forms, and the green 

navigation buttons represent reports.
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Click the “Master Schedule” button to 

open the Master Schedule form.

Click the “Employee Schedule” button 

to open the Employee Schedule report.

Notice how the color and outline of the 

buttons change slightly when a button 

is selected.  (See next two pages.)
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Notice how the color and outline of the 

buttons change slightly when a button 

is selected.  

This is the Master Schedule form.
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Notice how the color and outline of the 

buttons change slightly when a button 

is selected.  

This is the Employee Schedule report.
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Close the frmEmployeeNavigation and 

open each of the other two navigation 

forms included in this database.  They 

are the frmProductNavigation and 

frmServicesNavigation.

Notice the options and how the 

navigation forms are laid out in each 

case.  See next few pages.
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The frmProductNavigation navigation 

form.  Notice this form contains links to 

one form and three reports.  Look at 

each one of these.
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The Products by Category report.  
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The Products Purchased report.  
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The frmServicsNavigation navigation form 

contains two forms and one report. 
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The Service By Type report. 



CGS 2545: Database Concepts  (Lab #4)              Page 21 © Dr. Mark Llewellyn

Creating A Navigation Form

• Access provides six different predefined layouts for

navigation forms that are customizable – and they can

be redesigned even after they have been created.

• The predefined layouts use a drag-and-drop method to

add new objects to the navigation form.

• The navigation control bar is an area of a navigation

form that allows for the addition of new forms, reports,

or other database objects.

• All you do is drag a database object onto the navigation

control bar and a new navigation button is added to the

form.
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Creating A Navigation Form

• As you’ve just seen, as you played around with the

spaDB, when a button is clicked, the corresponding

form or report will be displayed in the subcontrol form.

• A subform control embeds one form into another form.

• Of the six predefined layouts to choose from, three

provide one level of navigation, either vertical or

horizontal, and three provide two levels of navigation,

either horizontal or a combination of both horizontal

and vertical.

• You are about to create a new navigation form similar

to those you’ve just viewed in the spaDB.
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1.  Click the CREATE tab.

2. Select the Navigation 

form option and click 

Vertical Tabs Left.

You should see the screen 

on the next page.
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1.  Close the Field List.

2.  Drag the frmCustomer 

form from the navigation 

pane to the [Add New] 

Button on the navigation 

form.
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1.  Your form now looks 

like this.

2.  Continue to add elements to the navigation form by dragging the 

frmCustomerInvoices, frmCustomerInvoices, frmCustomerPurchases, 

rptCustomerList, and rptScheduleBySuctomer to the navigation form.  When 

you are done your navigation form should look like the one on the next page.
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1.  Your form now looks 

like this.

2.  Continue to add elements to the navigation form by dragging the 

frmCustomerInvoices, frmCustomerInvoices, frmCustomerPurchases, 

rptCustomerList, and rptScheduleBySuctomer to the navigation form.  When 

you are done your navigation form should look like the one on the next page.
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1.  Click the DESIGN tab.

2.  In the Views Group 

select Design View
3.  In the Controls Group select Label, click to add a label to the 

right side of the form headers.  Resize the label as needed so that 

it fits on a single line.  See next slide.
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Custom label for navigation form

Save your newly created 

navigation form.  Save it 

with the name 

“frmCustomerNavigation”.
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Your new form now appears in the 

Forms Object list
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Modifying A Navigation Form

• Once a navigation form has been created, additional

objects can be added to the form, deleted from the

from, or rearranged on the form.

• Once buttons are added to the navigation form, the

captions, or text can be changed or replaced with icons

instead of the button caption to further customize the

form.

• Many new shapes are available in Access 2013 that

were specifically designed for use with navigation

controls like Next, Previous, and Exit.
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Modifying A Navigation Form

• Objects can be added to a navigation form simply by

dragging the object from the Navigation Pane to the

[Add New] button.

• To do this you obviously need to be able to see the

navigation form, so you should open it in either the

Layout View or the Design View. The Form View

does not show the [Add New] button.

• On the next couple of pages, we’ll add a new button to

our frmCustomerNavigation form.
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1. Open the 

frmCustomerNavigation 

form in Layout View

2. Drag the 

rptPurchaseByCustomer report 

object onto the [Add New] button

3. Repeat for the 

frmMasterSchedule object
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1. Switch back to the Form 

View and you should see the 

updated form.

2. Save the form
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Modifying A Navigation Form

• Objects can be deleted from a navigation form very

easily using one of two techniques:

1. Click the form button to be deleted, the press the DELETE

key on your keyboard.

2. Select the form button to be deleted, then right click the

mouse, then select Delete from the menu.

• The next page illustrates deleting a navigation form

object.

Note:

When you delete a button, make sure the button is selected with an orange border around

it. If you are in edit mode with the cursor blinking in the text instead of the button selected

with the orange border, you will delete the text of the button rather than the button itself.
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Once selected, either 

press the delete key 

on the keyboard or 

right click the mouse 

and select delete from 

the menu.
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Button gone!
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Modifying A Navigation Form

• Navigation form buttons can also be easily rearranged

on their level, or they can be moved from one level of

the form to another.

• This is done by simply dragging the button to the new

location. The next couple of pages illustrate the

technique.
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From the Layout View or 

Design View, select the 

rptScheduleByCustomer

button. (It will highlight in 

orange when selected.)
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Drag the 

rptScheduleByCustomer

button up the navigation pane.  

As you move up, you’ll see the 

orange line appear.  When the 

line is above the button where 

you want to reposition the 

rtpScheduleByCustomer

button, release the mouse 

button.

In this case, let’s put it above 

the frmCustomerInvoices

button.  (See next page.)
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The repositioned 

rptScheduleByCustomer

button.

Next, move it back down to 

where the button sits just 

above the rptCustomerList

button.

Save the navigation form.
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The final position of the 

rptScheduleByCustomer

button.

.
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Assessment Point #1

• At this point, be sure that you can create a navigation
form and add/remove objects from the navigation
form.

• Once you’re comfortable with these actions on a
navigation form move on and we’ll customize the
navigation form a bit more.
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Modifying the Appearance of Form Buttons

• Navigation buttons can be modified to customize the
form.

• The button shape and color can be changed.

• A theme can be added to either the navigation form or
to the whole database, including the navigation form.

• We’ll illustrate this by adding a theme to the database
and modifying the shape and color of buttons.

• First we’ll look at customizing the buttons.
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Customizing the Form Buttons

• In either the Layout View or the Design View,
double-click the Navigation Form title text, and type
Customer Navigation and then press ENTER.

• Select the icon to the left of the title and press the
DELETE key.
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Notice that the title 

and the icon shown on 

the top of the previous 

form are now gone.

Enter the new 

navigation form title 

Customer Navigation.
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1. Click the Design tab, and then in the 

Tools group click Property Sheet.

2. Under Selection type, scroll down and  

then click FormHeader.

3. Click the Format tab, and then locate 

Back Color.

4. Click the Builder button and then 

select White, Background 1, the first 

row under Theme Colors.

See next four pages:
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1. Click the Design tab, and then in the 

Tools group click Property Sheet.
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2. Under Selection type, scroll down and  

then click FormHeader.
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3. Click the Format tab, and then locate 

Back Color.
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4. Click the Builder button and then 

select White, Background 1, the first 

row under Theme Colors.

5. Close the Property Sheet window.
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Customizing the Form Buttons

• Now that the overall theme background color is set,
let’s modify the shape and color of the buttons on the
form.
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1. Click the frmCustomer button to 

select it.

2. Click the FORMAT tab.
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1. Click the Change Shape and select 

the Rounded Rectangle shape from 

the options.
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1. Click Quick Styles and select Subtle 

Effect – Blue Accent 1 (fourth row, 

second column).
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1. Form the Design tab, select the 

Property Sheet, then  on the Caption 

row, type Customer (right now it will 

say frmCustomer).  This will change 

the text of the button to read 

Customer.
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1. Click the HOME tab, and then in the 

Clipboard group, click Format Painter.

2. Click the frmCustomerInvoices button to 

change the button format to match the 

Customers button and then change the 

button caption to Invoices.
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1. Repeat the previous steps for each of the 

remaining “frm”-prefixed objects and change 

the captions to those shown here.
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1. Repeat the steps you just did to style the 

“frm”-prefixed buttons on all of the “rpt” 

buttons.  Make their Quick Styles be “Subtle 

Effect – Green, Accent 6” and change the 

button labels to be those shown here.
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1. In the DESIGN tab, click Themes and select 

“Integral”.  This will change the theme for all 

object in the database, including the 

navigation form.

2. Return to Form View and your navigation 

form should look like the one on the next 

page.  If it doesn’t go back and repeat any 

steps necessary to make it look the same.
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Assessment Point #2

• At this point be sure you understand how to
manipulate and style the buttons on a basic navigation
form.

• If any topic covered up to this point is unclear, go
back and redo that part of the lab until you understand
the techniques.

• You should be able to style, relocate, add, delete, and
modify navigation form objects at this point.
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Refining The User Interface
• Navigation forms do not display data from a table; therefore, they are an

unbound object. Because the suer does not have to move from record to record
or page to page, some of the form navigation properties can be removed.

• The navigation buttons and record selectors are often removed because they are
not needed. The ability to access a shortcut menu can be disabled as well as the
option to copy data and close the object.

• Essentially, any operation that would distract the user from the purpose of the
navigation form should be disabled or removed.

• If you find that your navigation form is cluttered with too many objects, you
can create multiple navigation forms and have one form open another.

• The key to making multiple navigation forms is to have them arranged in a way
that makes intuitive sense. A navigation form with only reports and another
with only forms may not simplify the navigation process through your database.
It is in effect just replicating the navigation pane.

• Instead, you should consider grouping forms and reports by topic or function as
shown on the next page.
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Refining The User Interface

Different task lists that a user might wish to perform



CGS 2545: Database Concepts  (Lab #4)              Page 64 © Dr. Mark Llewellyn

Refining The User Interface
• By grouping the different business functions, you create an intuitive and well-

defined user interface.

• A user should be able to complete all related tasks under a single navigation
form rather than having to move from one form to another form to find different
tasks.

• In the spa database example we are using in this lab, you might want to have
different pages to navigate service, product, employee, and customer tasks as
illustrated on the previous page.

• To accomplish this you would have a main navigation form with four
navigation buttons: Services, Products, Employees, and Customers. Clicking
on one of the buttons would open another navigation form with additional
objects related to the area you clicked.

• A well-defined user interface should make sense to any user, even one who has
no Access experience. The user should be able to look at the navigation form
and locate the form or report that they need.

• The remainder of this lab deals with creating a custom navigation form of this
type for the spa database.
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Creating A Main Menu Navigation Form
• Since the spa database will have four different navigation forms,

we’ll create a new navigation form to access each of the four
individual navigation forms.

• We’ll then add command buttons to navigate records within the
four areas as well as a button to close the database.

• First, let’s create the main navigation form.

• To start:

1. Click the CREATE tab

2. In the Forms group, click Navigation, and then click Horizontal Tabs

• You should see the form as shown on the next page.



CGS 2545: Database Concepts  (Lab #4)              Page 66 © Dr. Mark Llewellyn



CGS 2545: Database Concepts  (Lab #4)              Page 67 © Dr. Mark Llewellyn

1. As before, from the Design tab, select the 

Property Sheet and for the FormHeader

select the Format tab and set the Back Color 

to White, Background 1.

2. Then close the Property Sheet
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1. Drag the frmCustomerNavigation from the 

Navigation pane to the [Add New] button.

2. Repeat the process fir 

frmEmployeeNavigation, 

frmProductNavigation, and 

frmServicesNavigation to the [Add New] 

button.

3. Your form should look like the next page.
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1. Double-click the frmCustomerNavigation

tab, select the text and type Customers, 

press Enter.

2. Repeat for the remaining three tabs naming 

them Employees, Products, and Services.

3. You should wind up looking like the next 

page.



CGS 2545: Database Concepts  (Lab #4)              Page 70 © Dr. Mark Llewellyn



CGS 2545: Database Concepts  (Lab #4)              Page 71 © Dr. Mark Llewellyn

1. Click the Customers tab on the navigation form. Press and Hold the Shift 

key and click on the Services tab.  (All of the tabs should be included in 

the orange outline.)  

2. Click the FORMAT tab, in the control formatting group, click Change 

Shape and the click Round Same Side Corner Rectangle.

3. Click the Quick Styles and select Subtle Effect – Dark Freen, Accent 5.

4. You should wind up looking like this page.
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1. Double click the Navigation form title and select the text, then type 

Turquoise Oasis Spa Database.

2. Save the form as frmTurquoiseSpa.



CGS 2545: Database Concepts  (Lab #4)              Page 73 © Dr. Mark Llewellyn

Creating A Main Menu Navigation Form
• As a final step in the main navigation form, let’s add a logo image

to the main form.

• Download the “TurquoiseOasisSpaLogo.jpg” file from the course
website or WebCourses (under lab 4 files).
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1. Click the icon located nest to the form title and then click the DESIGN tab.

2. In the Controls group, click Insert Image, Click browse and the select the 

TurquoiseOasisSpa.jpg file you downloaded.

3. Click ok to insert the new image
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1. On the DESIGN tab, click the Property Sheet.  

2. In the Property sheet pane, click the Format tab.

3. Click the Size Mode box arrow and then click Zoom.

4. Type 3 for the width and then type 0.8 for the height.

5. Save and close the form.
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Add Navigation Buttons To The Form
• The navigation forms help organize the user interface to the

database. However, individual records are still navigated with the
navigational bars. For users unfamiliar to Access, buttons near the
top of forms are more intuitive than the navigational arrows at the
bottom of a from.

• In this next part of the lab, you will add some buttons for
navigation at the top of the form and turn off the navigation bar.

• Command buttons are available in several different categories.
Record navigation buttons replicate most of the navigation tools
on the navigation bar. You can create buttons to go to the first,
next, last, and previous records.

• The table on the next page shows the available buttons for each
category.
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Add Navigation Buttons To The Form
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Add Navigation Buttons To The Form
• If you look at the Employee Navigation form, the Product

Navigation form, or the Service Navigation form, you will see that
there are buttons on the navigation forms for the user to click to
find a record, add a record, or go to the previous and next records.

• You are about to add these to the Customer navigation form.
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1. Open the frmCustomer form in the Design View.

2. Click the CustomerID text box, press and hold the 

SHIFT key and then click all the text boxes and labels.  

Drag all of the controls down to the 0.5” mark on the 

vertical ruler in the DETAIL area)

3. Click the DESIGN tab, in the Controls group, click 

Button (the one with XXXX on it). And then click the 

upper left corner for the form detail section to add the 

button
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1. When the Command Button Wizard pops up, under the 

Categories list, verify that Record Navigation is 

selected.  On the Actions list, click Find Record and then 

click Next.

2. Click the DESIGN tab, in the Controls group, click 

Button (the one with XXXX on it). And then click the 

upper left corner for the form detail section to add the 

button
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1. Click Text, select the text and type Find Customer, then 

click Next.
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1. Name the button cmdFindCustomer

2. Click Finish.
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1. Repeat… click the XXXX button again and then click to 

the right of the button you just created. 
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1. This time select Record Operations in the Command 

Button Wizard and make the Action Add New Record. 

Then click Next. 



CGS 2545: Database Concepts  (Lab #4)              Page 86 © Dr. Mark Llewellyn

1. Make the text on the button read Add New Customer. 

Then click Next. 
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1. Name the button cmdAddNewCustomer. Then click 

Finish. 
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1. Repeat the process for two more buttons for finding the 

next customer and the previous customer.  Use the 

same naming conventions we’ve been using.
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1. Click the first button and then hold down the SHIFT key and click the 

remaining three buttons so that all four are highlighted.

2. Click the ARRANGE tab, in the Sizing and Ordering group, click Align the 

click Top.

3. In the Sizing and Ordering group, click Size/Space and click Equal Horizontal.

4. Close the form and save changes.
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1. View of the modified Customer navigation form completed in form view.
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Add Navigation Buttons To The Form
• Only a few more things to do before we are done.

• Next, we want to add an exit button to the main navigational form.

• Open the frmTurquoiseSpa navigational form, switch to the design
view, click the DESIGN tab, and in the controls group click the
BUTTON label (the XXXX one), the click under the titel of the
main form header.
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1. Place the button here and when the Command Button 

Wizard pops-up, select Application, with the Action 

being Quit Application.  Click next andmake the text of 

the button read Exit Database. Finally, rename the 

buttom cmdExitDatabase and finish.
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Removing Navigation Arrows and Selectors

• Look at the forms such as frmEmployeeNavigation and you will
see that the navigation arrows and record selectors have all been
removed.

• This forces the user to use the buttons to manage the records.

• With the addition of the navigation buttons, the navigation arrows
and record selectors create duplicate functionality.

• Our next step is to remove the navigation arrows and record
selectors from the Customer form.
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We want to get rid of these arrows and record selectors on 

our forms and force the user to use the buttons we’ve 

provided.
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We want to get rid of these arrows and record selectors on 

our forms and force the user to use the buttons we’ve 

provided.
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1. Open the customer form and switch to the layout view, 

click the DESIGN tab and then in the Tools group click 

the Property Sheet.

2. On the Selection type, locate Form and select it.
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1. Scroll down until you find Record Selector and select 

No.

2. Scroll down until you find Navigation Buttons and select 

No.

3. Close the property sheet and save the form changes.
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The navigational arrows and record 

selectors are gone.
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Setting Start-up Display Options

• Once your database is designed, the forms and reports have been
created, and a navigation system and user interface in place, you’ll
have an application that others can use.

• To make your application as user-friendly as possible, you can
name the application and remove options available to database
designers. By doing this you reduce the probability of changes
being made to the data or database structure, either intentionally or
accidentally by the end user.

• These options include removing access to certain applications
options such as the Navigation Pane, the ribbon, and various
toolbar options.

• Optional commands, such as those that compact and repair the
database when it is closed, may be set to run automatically so that
the user does not need to worry about maintenance tasks.
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Setting Start-up Display Options

• Changing the application title helps to better identify the
application and give it an identity separate from the actual
database.

• Selecting a start-up form will determine which form opens when
the application is started. Restricting access to the Navigation
Pane require the user to use the interface you have developed.

• The final part of this lab will show you how to set the application
title and designate the main navigation form you just created to
become the start-up form.

• To start this process, click the FILE tab , then click Options, and
select Current Database. You’ll see the pop-up shown on the next
page.
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For the Application Title enter 

Turquoise Oasis Spa.

For the Display Form enter/select 

frmTurquoiseSpa.

Check the Compact on Close box

Uncheck the Display Navigation Pan 

box



CGS 2545: Database Concepts  (Lab #4)              Page 102 © Dr. Mark Llewellyn

Setting Start-up Display Options

• When you click OK, Access will pop-up the following message.

• Click OK and restart the database.

• When the database restarts, you’ll see the main navigation form
appear and no Navigation Pane will be present. It should look like
the next page.

• Notice too, that the application title is now different.



CGS 2545: Database Concepts  (Lab #4)              Page 103 © Dr. Mark Llewellyn



CGS 2545: Database Concepts  (Lab #4)              Page 104 © Dr. Mark Llewellyn

Setting Start-up Display Options

• To be able to return to, and access the original database, simply
undo the previous steps:

– From the FILE tab, click Options.

– Select Current Database.

– Check the Display Navigation Pane check box to restore the navigation
pane. You can also reset the display form to None if you’d like.

– Click OK twice and restart the database.
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Lab Assignment #4

Lab Assignment #4 – Due March 28th by 11:59 pm (WebCourses time) – 50

points

Create a new (different from the one we just created in this lab) main

navigation form that includes a different set of at least three tabs that lead to

subforms other than those we used in this lab. Your navigation form must

have at least three tabs at the top level and within those three tabs the

subnavigation forms should have at least four tabs each. Name this main

form “MainNavigation”

You can mix and match the different design layouts, we won’t impost a

uniform look across all of the various navigation levels as we did in this lab.

This way you can play around a bit with the different options that are

available.

For this lab you will be uploaded your modified database, not taking screen

shots.

Name your database using this style: LastNameFirstNameLab4.accdb.


